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Preface
Use the Informatica® PowerExchange® for SAS User Guide to learn how to read from or write to SAS by using 
the Developer tool. Learn to create a SAS connection and develop and run mappings and dynamic mappings 
in an Informatica domain.

Informatica Resources
Informatica provides you with a range of product resources through the Informatica Network and other online 
portals. Use the resources to get the most from your Informatica products and solutions and to learn from 
other Informatica users and subject matter experts.

Informatica Network
The Informatica Network is the gateway to many resources, including the Informatica Knowledge Base and 
Informatica Global Customer Support. To enter the Informatica Network, visit 
https://network.informatica.com.

As an Informatica Network member, you have the following options:

• Search the Knowledge Base for product resources.

• View product availability information.

• Create and review your support cases.

• Find your local Informatica User Group Network and collaborate with your peers.

Informatica Knowledge Base
Use the Informatica Knowledge Base to find product resources such as how-to articles, best practices, video 
tutorials, and answers to frequently asked questions.

To search the Knowledge Base, visit https://search.informatica.com. If you have questions, comments, or 
ideas about the Knowledge Base, contact the Informatica Knowledge Base team at 
KB_Feedback@informatica.com.

Informatica Documentation
Use the Informatica Documentation Portal to explore an extensive library of documentation for current and 
recent product releases. To explore the Documentation Portal, visit https://docs.informatica.com.

If you have questions, comments, or ideas about the product documentation, contact the Informatica 
Documentation team at infa_documentation@informatica.com.
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Informatica Product Availability Matrices
Product Availability Matrices (PAMs) indicate the versions of the operating systems, databases, and types of 
data sources and targets that a product release supports. You can browse the Informatica PAMs at 
https://network.informatica.com/community/informatica-network/product-availability-matrices.

Informatica Velocity
Informatica Velocity is a collection of tips and best practices developed by Informatica Professional Services 
and based on real-world experiences from hundreds of data management projects. Informatica Velocity 
represents the collective knowledge of Informatica consultants who work with organizations around the 
world to plan, develop, deploy, and maintain successful data management solutions.

You can find Informatica Velocity resources at http://velocity.informatica.com. If you have questions, 
comments, or ideas about Informatica Velocity, contact Informatica Professional Services at 
ips@informatica.com.

Informatica Marketplace
The Informatica Marketplace is a forum where you can find solutions that extend and enhance your 
Informatica implementations. Leverage any of the hundreds of solutions from Informatica developers and 
partners on the Marketplace to improve your productivity and speed up time to implementation on your 
projects. You can find the Informatica Marketplace at https://marketplace.informatica.com.

Informatica Global Customer Support
You can contact a Global Support Center by telephone or through the Informatica Network.

To find your local Informatica Global Customer Support telephone number, visit the Informatica website at 
the following link: 
https://www.informatica.com/services-and-training/customer-success-services/contact-us.html.

To find online support resources on the Informatica Network, visit https://network.informatica.com and 
select the eSupport option.

Preface        7
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C h a p t e r  1

Introduction to PowerExchange 
for SAS

This chapter includes the following topics:

• PowerExchange for SAS Overview, 8

• PowerExchange for SAS Architecture, 8

• User Authentication, 9

PowerExchange for SAS Overview
PowerExchange for SAS provides connectivity between Informatica Developer and SAS. It is an extension of 
the Informatica data integration tools, and facilitates the use of SAS data objects in your data integration 
processes.

PowerExchange for SAS consists of the following components:
Client Component

Extends the Developer tool capabilities to facilitate the registration and use of SAS data objects.

Data Integration Service Component

Extends the Data Integration Service so that it can read data from and write data to SAS.

Model Repository Service Component

Extends the Model Repository Service so that it can store SAS metadata.

Communication Component (SPI Server)

Completes all the tasks that are requested from the machine that hosts the SAS data objects.

PowerExchange for SAS Architecture
The central component of the architecture for PowerExchange for SAS is the Communication component, 
which is also known as the SPI Server. The SPI Server is a multithreaded TCP/IP listener service. It is 
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installed on the machine that runs SAS, and handles requests from the Developer tool and the Data 
Integration Service.

When you use the Developer tool to import SAS data objects, the Client component requests the metadata 
from the SPI Server. The SPI Server starts an SPI session to retrieve the information from SAS and then 
passes this information to the Client component. When you save the SAS data objects, the Model Repository 
Service component saves them to the Model repository.

When you run a mapping that contains a SAS source or target, the Data Integration Service uses the Data 
Integration Service component to start a session with the SPI Server. The SPI Server accesses SAS data and 
passes it back to the Data Integration Service component for processing the data.

User Authentication
User authentication is required to connect to an SPI Server.

PowerExchange for SAS users are classified as normal users and administrators.

Normal users

Normal users have the permission to connect to the SPI Server and fetch table metadata when importing 
SAS data objects. They also have the permission to initiate requests to read data from or write data to 
SAS.

Administrator users

Administrator users have the same permissions as normal users. Additionally, administrator users have 
the permission to remotely stop the SPI Server.

User Administration
You can administer users locally. Use the SPI Server Configuration tool to add or remove a user, change a 
password, or change the type of a user.

After you install PowerExchange for SAS, two users are defined with default passwords being equal to the 
user names.

User Authentication       9



C h a p t e r  2

PowerExchange for SAS 
Installation and Configuration

This chapter includes the following topics:

• PowerExchange for SAS Installation and Configuration Overview, 10

• Installing PowerExchange for SAS, 11

• Installing the Client Component, 11

• Installing the Data Integration Service Component, 11

• Installing the Communication Component, 12

• Configuring the Communication Component, 14

• Upgrading PowerExchange for SAS, 16

PowerExchange for SAS Installation and 
Configuration Overview

To install and configure PowerExchange for SAS, perform the following steps:

1. Install PowerExchange for SAS.

2. Configure the Communication component.

Prerequisites
Before you install PowerExchange for SAS, perform the following tasks:

1. Install the Informatica services.

2. Install the Informatica clients. When you install the Informatica clients, the Developer tool is installed.

3. Create a Data Integration Service and a Model Repository Service in the Informatica domain.

4. Ensure that the rsync utility is installed on the Informatica client and server machines. The rsync 
commands are used by the installers for logging. You must run the rsync command and verify if the 
rsync command runs successfully.
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Installing PowerExchange for SAS
When you install PowerExchange for SAS, you install the following components that allow the Developer tool 
to access SAS:

• Client component. Allows you to import SAS metadata, create mappings, and create connection objects 
by using the Developer tool.

• Server component. Allows the Data Integration Service to run SAS sessions.

• SPI Server component. Allows the Developer tool and Data Integration Service to access the SAS host.

You can use the Full Installation option to install all the components simultaneously.

Installing the Client Component
Install the Client component on the machine where you installed Informatica Data Services.

1. Unzip the client installer directory. 

2. At the command prompt, navigate to the location where the installClient.bat file is stored in the 
client installer directory. 

3. At the command prompt, enter the following command: installClient.bat 
<InformaticaClientInstallationDirectory> 
For example, enter installClient.bat C:\Informatica\9.6.1\clients.

The Client component is installed.

Installing the Data Integration Service Component
If you configure the Data Integration Service to run on primary and backup nodes, install the Data Integration 
Service component on each node that is configured to run the Data Integration Service process. When you 
install the Data Integration Service component, the Model Repository Service component also gets installed.

You can install the Data Integration Service component on Windows or UNIX operating systems.

Installing the Data Integration Service Component on Windows
To install the Data Integration Service component on Windows, perform the following steps:

1. Unzip the server installer directory. 

2. At the command prompt, navigate to the location where the installServer.bat file is stored in the 
server installer directory. 

3. At the command prompt, enter the following command: installServer.bat 
<InformaticaServerInstallationDirectory> 
For example, enter installServer.bat C:\Informatica\9.6.1.

The Data Integration Service component is installed.

Installing PowerExchange for SAS       11



Installing the Data Integration Service Component on UNIX
To install the Data Integration Service component on UNIX, perform the following steps:

1. Unzip the server installer directory. 

2. At the command prompt, navigate to the location where the installServer.sh file is stored in the server 
installer directory. 

3. At the command prompt, enter the following command: installServer.sh 
<InformaticaServerInstallationDirectory> 
For example, enter installServer.sh C:\Informatica\9.6.1.

The Data Integration Service component is installed.

Installing the Communication Component
Install the Communication component, also known as the SPI Server, on the machine that runs the SAS 
environment that you want to connect to.

The Communication component does not connect to the Model repository. The configuration is stored 
locally.

Installing the Communication Component on Windows
On Windows, the Communication component runs as a Windows service.

To install the Communication component on Windows, perform the following steps:

1. Run setup.exe from the following location: <DownloadLocation>\Win32\setup.exe 
2. Click Yes to install PowerExchange for SAS. 

The Welcome window appears.

3. Click Next and select a directory when you want to install the Communication component. 

Click Browse to find a directory or use the default directory.

4. Click Next, select SAS Communication Component, and click Next. 

5. Select a Start menu folder for program shortcuts and click Next. 

A confirmation page appears.

6. Click Install. 

The Communication Component Setup Wizard appears.

7. Click Next. 

12       Chapter 2: PowerExchange for SAS Installation and Configuration



8. On the SPI Server Configuration page, enter the following information and click OK: 

Property Description

Port Number TCP/IP port number for the SPI Server listener process.

Log File Path Absolute path to the log file.
Default is C:\PowerExchange for SAS

SAS Pre Post Code Defines if SAS exits are allowed.
Default is No.

Application Path Absolute path to the SAS executables.
Default is C:\Program Files\SAS\sas.exe

Working Directory Path Directory path for the SAS working environment.
Default is C:\testdata

Autoexec Name Name of the autoexec file.
Default is autoexec.sas.

9. Click the Users button to add, edit, or delete users, or to change user attributes. 

10. Click OK. 

11. Review the license agreement and click Yes. 

The Communication component is installed.

Installing the Communication Component on UNIX
Install the Communication component with a user account that has authorization to start SAS and to access 
the SAS data that you want to read or write. PowerExchange for SAS uses the user account to access the 
SAS data.

To install the Communication component on UNIX, perform the following steps:

1. Enter sh install.sh at the prompt. 

2. Enter the path to the Informatica installation directory. 

By default, the server components are installed in the following location: <Informatica installation 
directory>/<version folder>

3. Select a directory where you want to install the Communication component. 

4. Follow the instructions and select Install SAS Communication Component. 

The Communication component is installed.

The following libraries are installed with the SPI Server binaries:

• libicuuc.<ext>.34
• libicui18n.<ext>.34
• libicudata.<ext>.34

where <ext> stands for the shared library extension for the UNIX operating system that you use. For example, 
libicuuc.so.34 applies to the Linux operating system.

Installing the Communication Component       13



Include these libraries in the system library path by using one of the following options:

• Add the SPI Server installation directory to the library search path. For example:export 
LD_LIBRARY_PATH=/home/PowerExchange'ForSAS:$LD_LIBRARY_PATH

• Move the library files to a directory that exists in the library search path. For example: /usr/local/lib

Configuring the Communication Component
To configure the Communication component, use the configuration tool to maintain the configuration files.

The configuration file is located in the directory when you installed the Communication component.

Configuring the Communication Component on Windows
To start the configuration tool on Windows, use the SPI Server Configuration in the Start menu. Use SPI 
Server Configuration tool to configure the TCP/IP port where the SPI Server listens, the location of the SPI 
Server log file, and the SPI Server users and passwords.

You must also configure the SAS environment.

• Working Directory Path: Enter the directory from which SAS runs.

• Autoexec Name: Enter the file name that SAS uses as the initialization file.

In the SAS initialization file, you can assign SAS libraries or libnames that must be accessible by the 
Developer tool to access the SAS metadata, and by the Data Integration Service to access the SAS data.

The following snippet shows a sample SAS autoexec file: xe "SAS autoexec file:

/*
  Sample SAS autoexec file
*/
LIBNAME whdata 'W:\data\saswhdata' ;
LIBNAME oltp   'W:\data\sales\2008Q1' ;

For more information about valid LIBNAME syntax and options, see the SAS documentation.

User Administration on Windows
You can add or remove users, and change the user password or the user administrator property.

To perform user administration on Windows, perform the following steps:

1. In the Configuration dialog box, click Users.

2. In the User Administration dialog, make the necessary changes, and click Close.

Configuring the Communication Component on UNIX
To start the configuration tool on UNIX, perform the following steps:

1. At the shell prompt, navigate to the SPI Server installation directory. 

2. At the shell prompt, enter ./spiconfig. 

3. Select an option that you want to change. 

The configuration tool prompts you for a new value.

4. Select Users to enter the user administration details. 
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Configuring the SAS Autoexec File
Use the SAS autoexec file named autoexec.sas to configure the SAS environment.

Session and User Identification
The name of the SPI Server user who accesses the SAS environment is passed to the environment where SAS 
runs.

The values of this property can thus be used for conditional initialization logic in the SAS autoexec script.

The following system variable provides the user name to the SAS process:

System Variable Available Description

TBPC_USER_NAME client/server Name of the connected SPI Server user.

You can use the SAS function sysget() to retrieve system variables.

For example:

/* Store system variables into SAS macro variables: */ 

usrname = sysget("TBPC_USER_NAME"); 

/* Use the SAS macro variables to code logic: */ 

............. 

............. 

/* End of logic */ 
When the Developer tool initiates a connection to the SAS machine, the system variables that are unavailable 
for client connections contain no meaningful information. The system variable values default to "_NONE_".

Reading SAS Character Columns with Binary Zeros
SAS supports binary zero bytes in character columns. However, the Developer tool does not support 
characters with binary zeros. You can replace binary zeros with NULL characters before passing data to the 
Developer tool.

To replace binary zeros with NULL characters, assign the macro variable CHCKNLLS in the SAS autoexec file. 
Add the following line in the SAS autoexec file:

%let CHCKNLLS=YES;

Starting the Communication Component on Windows
On Windows, the SPI Server runs as a Windows service called Informatica SPI Server.

You can start and stop this service in the following ways:

• Set Startup type to manual. Start and stop the service by using the Windows Service Manager.

• Set Startup type to automatic. The service starts automatically when you start the Windows system.

• Use a Windows command line or script file. To start, enter the following command: net start 
"Informatica SPI Server". To stop, enter the following command: net stop "Informatica SPI 
Server".
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Starting the Communication Component on UNIX
On UNIX, the SPI Server is an executable that runs as a daemon process.

To start the SPI Server, navigate to the directory in which you installed the SPI Server and enter the following 
command:

spiserver

Check the SPI Server log file to make sure that the server started successfully. For more information about 
the location of the log file, see “Configuring the Communication Component” on page 14

To stop the SPI Server, enter the following command:

spiserver stop <host> <portnumber> <administrator name>

You can build an initialization script to start the SPI Server automatically when the system starts. For more 
information, see your system documentation.

Note: If the SPI Server does not shut down normally, it might not restart. If this issue occurs, remove the SPI 
Server lock file in the SPI Server working directory, and then restart the SPI Server.

Upgrading PowerExchange for SAS
To upgrade PowerExchange for SAS, perform the following tasks:

1. Upgrade the PowerExchange for SAS components.

2. Configure the communication component.

Upgrade the PowerExchange for SAS Components
To upgrade PowerExchange for SAS, perform the following tasks:

1. Stop the Informatica services. 

2. At the command prompt, navigate to the location where the installServer.sh file is stored in the server 
installation directory. 

3. Enter the following command: 

./installServer.sh 
<Informatica_Installation_directory> true false

where the option to upgrade the installer is set to true and the option to skip registration is set to false.

For example,

./installServer.sh /home/Informatica/10.5 true false
where /home/Informatica/10.5 is the Informatica installation directory.

4. To make sure that the SAS plugin is re-registered successfully, navigate to the following directory: 

<Informatica_installation_directory>/isp/bin
5. Run the following command: 

infasetup.sh validateAndRegisterAllFeatures
6. Start the Informatica services. 
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Upgrade the Communication Component
Install the communication component or the SPI server on the SAS server machine.

If you want to keep the communication component from the earlier version, install the new version of the 
communication component in a different directory with the new SPI port in the SAS server machine.

Alternatively, if you want to use the same SPI server port provided in the SAS connection object as in the 
earlier version, you must stop the installed version of the SPI Server process. Then, configure the same SPI 
server port with the new SPI server component and then start the new SPI Server.
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C h a p t e r  3

SAS Connections
This chapter includes the following topics:

• SAS Connection Overview, 18

• SAS Connection Properties, 18

• Creating a SAS Connection, 19

SAS Connection Overview
Use a SAS connection to access the SAS data.

Create a connection to import SAS data set metadata and create data objects, preview data, and run 
mappings. When you create a SAS connection, you define the connection attributes that the Data Integration 
Services uses to connect to the SAS database.

SAS Connection Properties
You can create and manage a SAS connection in the Administrator tool or the Developer tool.

Note: The order of the connection properties might vary depending on the tool where you view them.

When you create a SAS connection, you enter information for metadata and data access.

The following table describes SAS connection properties:

Property Description

Name Name of the SAS connection.

ID String that the Data Integration Service uses to identify the connection. The ID is not case sensitive. It 
must be 255 characters or less and must be unique in the domain. You cannot change this property 
after you create the connection. Default value is the connection name.

Description Description of the connection. The description cannot exceed 765 characters.

Location Domain where you want to create the connection.

Type Type of connection.
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The following table describes the SAS connection properties for data access:

Property Description

Host Host name of the machine that runs the SPI Server.

Port Port number of the machine that runs the SPI Server. Must correspond to the port number that you used 
while configuring the SPI Server.

User Name User name. Must be configured in the SPI Server configuration.

Password Password for the user.

Creating a SAS Connection
Create a connection in the Developer tool before you create a SAS data object.

1. Click Window > Preferences. 

2. Select Informatica > Connections. 

3. Expand the domain in the Available Connections list. 

4. Select Enterprise Applications > SAS and click Add. 

5. Enter a connection name. 

6. Enter an ID for the connection. 

7. Optionally, enter a connection description. 

8. Select the domain where you want to create the connection. 

9. Select SAS as the connection type. 

10. Click Next. 

11. Configure the connection details for metadata access and data access. 

12. Click Test Connection to verify the connection to SAS. 

13. Click Finish. 
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C h a p t e r  4

SAS Data Objects
This chapter includes the following topics:

• SAS Data Object Overview, 20

• SAS Data Object Views, 20

• SAS Data Object Overview Properties, 21

• Importing a SAS Data Object, 21

• SAS Data Object Read Operation Properties, 22

• Creating a Data Object Read Operation, 25

• SAS Data Object Write Operation Properties, 26

• Creating a Data Object Write Operation, 28

SAS Data Object Overview
A SAS data object is the representation of data that is based on a SAS data set. You can configure the data 
object read operation properties and write operation properties to determine how data can be read from SAS 
sources and written to SAS targets.

Import the SAS data set into the Developer tool to create a SAS data object. Create a data object read 
operation or write operation for the SAS data object. Then, you can add the data object operation to a 
mapping.

SAS Data Object Views
The SAS data object contains views to edit the object name and the properties.

After you create a SAS data object, you can change the data object and data object operation properties in 
the following data object views:

• Overview view. Use the Overview view to edit the SAS data object name, description, and data sets.

• Data Object Operation view. Use the Data Object Operation view to view and edit the properties that the 
Data Integration Service uses when it reads data from or writes data to SAS data set.

When you create mappings with a SAS source or target, you can view the data object properties in the 
Properties view.
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SAS Data Object Overview Properties
The SAS Overview section displays general information about the SAS data object and detailed information 
about the SAS data set that you imported.

You configure the following general properties for a SAS data object:

Name

Name of the SAS data object.

Description

Description of the SAS data object.

Connection

Name of the SAS connection. Click Browse to select another SAS connection.

You can view the properties for the SAS data set that you import:

Name

Name of the SAS data set.

Type

Native data type of the SAS data set.

Description

Description of the SAS data set.

Importing a SAS Data Object
Import a SAS data object to add to a mapping.

1. Select a project or folder in the Object Explorer view. 

2. Click File > New > Data Object. 

3. Select SAS Data Object and click Next. 

The SAS Data Object dialog box appears.

4. Enter a name for the data object. 

5. Click Browse next to the Location option and select the target project or folder. 

6. You can choose the Access Type as Connection to SAS or File Import. 

7. If you choose File Import, click Browse in the Resource Location field to choose a SAS file on the local 
machine. 

8. If you choose Connection to SAS, click Browse next to the Connection option and select the SAS 
connection from which you want to import the SAS data set metadata. Perform the following steps: 

a. To add a table, click Add next to the Selected Resources option. 

The Add Resource dialog box appears.

b. Select a table. You can navigate to it or search for it. 

• Navigate to the SAS data set that you want to import and click OK.
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• To search for a data set, enter the name of the data set you want to add. Click OK.

c. If required, add more tables to the SAS data object. 

You can also add tables to a SAS data object after you create the data object.

9. Click Finish. 

The data object appears under Data Objects in the project or folder in the Object Explorer view.

SAS Data Object Read Operation Properties
The Data Integration Service reads data from a SAS data set based on the data object read operation 
properties. The Developer tool displays the data object read operation properties for the SAS data object in 
the Data Object Operation section.

You can view or configure the data object read operation from the output and source properties.

Output properties represent the data that the Data Integration Service passes into the mapping pipeline. 
Select the output properties to edit the port properties and specify the advanced properties of the data object 
read operation.

Source properties represent the data that the Data Integration Service reads from the SAS data set. Select the 
source properties to view data such as the name and description of the SAS data set, create key columns to 
identify each row in a data object read operation, and create key relationships between data object read 
operations.

Output Properties of a Data Object Read Operation

General Properties

The general properties list the name and description of the data object read operation.

Ports Properties

The output ports properties list the data types, precision, and scale of the data object read operation.

You configure the following output ports properties in a data object read operation:
Name

Name of the port.

Type

Data type of the port.

Precision

Maximum number of significant digits for numeric data types or maximum number of characters for 
string data types. For numeric data types, precision includes scale.

Scales

Maximum number of digits after the decimal point for numeric values.

Description

Description of the port.
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Source Properties

The sources properties list the SAS data sets in the data object read operation.

Query Properties

The Query properties allow you to specify Filter and Join conditions in the data object read operation.

You can configure the following Query properties:

Filter

The Filter type defined for a SAS source. You can specify a where clause condition while reading the SAS 
data.

Join

The Join type defined for a SAS source. This is an optional property.

Advanced Properties

The advanced properties allow you to specify data object read operation properties to read data into SAS 
data sets.

You can configure the following advanced properties in the data object read operation:

Trace

Boolean property to implement the SAS trace option. Use the SAS trace option to toggle verbose logging.

PreSASCode and PostSASCode

Facilitates the invocation of a SAS Macro or a SAS %include statement to be executed just before or just 
after the reading of the SAS Source object. The SPI Server must be configured to allow the execution of 
SAS exits. The SAS Macro to be invoked must be defined in the autoexec.sas file that is part of the SPI 
Server configuration.

Table Name

The name of the table to read from SAS.

Library Name

The library name associated with the SAS table from which the Data Integration Service reads the data.

SAS File Path

The path to the directory that contains the SAS file from where the Data Integration Service can read 
data directly.

Source File Type

Determines whether the Data Integration Service reads data from a file or from a file list.

You can select from the following options to read data:

• Direct. Reads data from a SAS file you specify.

• Indirect. Reads data from a SAS file list you specify.

SAS File List

The name of the file list .txt file that contains a list of SAS files from which to read data. The Data 
Integration Service reads data from the file list .txt file that is available in the path you specify in SAS File 
Path field.

Within the .txt file, you can specify either the name of the SAS file or the full path where the SAS file is 
available on the Informatica server machine. When you do not specify a path for the SAS file in the file 
list, the Integration Service searches for the SAS file you specify in the SAS File Path field.
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Encoding

Determines the encoding format of the SAS table or SAS file.

You can select from the following supported encoding formats to read data:

• English

• Shift-JIS

• UTF-8

Source Properties of the Data Object Read Operation
The source properties represent the data that is populated based on the SAS data sets that you added when 
you created the data object. The source properties of the data object read operation include general and 
column properties that apply to the SAS data sets.

You can view the source properties of the data object read operation from the General, Column, and 
Advanced tabs.

General Properties

The general properties display the name and description of the SAS data set.

Column Properties

The column properties display the data types, precision, and scale of the source property in the data object 
read operation.

You can view the following source column properties of the data object read operation:
Name

Name of the column property.

Type

Native data type of the column property.

Precision

Maximum number of significant digits for numeric data types or maximum number of characters for 
string data types. For numeric data types, precision includes scale.

Scales

Maximum number of digits after the decimal point for numeric values.

Description

Description of the column property.

Is Primary Key

Determines if the column property is a part of the primary key.

Format, Informat, Length, and Label

Determines the SAS field attributes. You can edit the SAS field attributes. However, you cannot change 
the length for string fields. The length for string fields follows the precision value on the Columns tab.

Advanced Properties

The advanced property displays the physical name of the SAS data set.
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Creating a Data Object Read Operation
You can create the data object read operation for one or more SAS data objects. You can add a SAS data 
object read operation to a mapping as a source.

1. Select the data object in the Object Explorer view. 

2. Right-click and select New > Data Object Operation. 

The Data Object Operation dialog box appears.

3. Enter a name for the data object operation. 

4. Select SASDataRead as the type of data object operation. 

5. Click Add. 

The Select Resources dialog box appears.

6. Select the SAS data set for which you want to create the data object read operation and click OK. 

You can select only one data object for a data object read operation.

7. Click Finish. 

The Developer tool creates the data object read operation for the selected data object.

Joining tables in SAS
You can join tables in SAS by selecting the tables into one data object read operation. The SAS system 
performs the join.

The attributes related to the table join can be accessed through the Join tab in the Query properties of Output 
Properties of a data object read operation:

• Join Type. Supported join types are the inner join, full outer join, left outer join, and right outer join. Note 
that only in the case of an inner join more than two tables can be joined.

• Join Condition. You can define the condition that defines the join to be executed. The join condition is 
entered using the join condition builder dialog that you can access by clicking the button next to the join 
condition field. For a full description of valid join conditions in SAS, see the SAS documentation. If no join 
condition is specified, a join condition will be generated based on the existing primary key and foreign key 
relations between the sources as defined for the data objects.

• Left table. When you select left outer join or right outer join as the join type, this option lets you define 
which of the two participating tables is to be considered as the left table.

Reading Data from a SAS File or List
When you configure a SAS operation, you can choose to read data from a SAS file or from a SAS file list.

Reading Data Directly from SAS Files
You can directly read data from SAS files using the Direct file source file type option.

When you create a SAS data object, select the access type as File Import to import metadata from a SAS file. 
In the Resource Location field, specify the directory on the local machine where the SAS file resides.

In the SAS data object read operation advanced properties, select Direct as the Source File Type to indicate 
that you want the Data Integration Service to read data from a SAS file.
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In the SAS data object read operation advanced properties, specify the SAS file path from where you want to 
read the data. When you run the mapping, the Data Integration Service uses the specified path to read data 
directly from the SAS file.

Reading Data Indirectly from a SAS File List
A SAS file list is a .txt file that contains a list of SAS file names from which you want the Data Integration 
Service to read data. When you configure a read operation to read data from a SAS file list, you must use the 
Indirect source file type option.

In the SAS data object read operation advanced properties, select Indirect as the Source File Type to indicate 
that you want the Data Integration Service to read data from SAS files specified within the SAS file list.

Specify the SAS file list name along with the path in the SAS File List field. When you do not specify a path 
for a SAS file within the SAS file list, the Data Integration Service searches for the SAS file list in the specified 
SAS File Path field.

SAS Data Object Write Operation Properties
The Data Integration Service writes data to a SAS data set based on the data object write operation 
properties. The Developer tool displays the data object write operation properties for the SAS data object in 
the Data Object Operation section.

You can view or configure the data object write operation from the input and target properties.

Input properties represent the data that the Data Integration Service passes into the mapping pipeline. Select 
the input properties to edit the port properties and specify the advanced properties of the data object write 
operation.

Target properties represent the data that the Data Integration Service writes to the SAS data set. Select the 
target properties to view data such as the name and description of the SAS data set, create key columns to 
identify each row in a data object write operation, and create key relationships between data object write 
operations.

Input Properties of a Data Object Write Operation
The input properties represent the data that the Data Integration Service passes into the mapping pipeline. 
Select the input properties to edit the port properties of the data object write operation. You can also specify 
advanced data object write operation properties to load data into SAS data sets.

The input properties of the data object write operation include general properties that apply to the data object 
write operation. They also include port, source, and advanced properties that apply to the data object write 
operation.

You can view and change the input properties of the data object write operation from the General, Ports, 
Sources, and Advanced tabs.

General Properties

The general properties list the name and description of the data object write operation.

Ports Properties

The input ports properties list the data types, precision, and scale of the data object write operation.

You can configure the following input ports properties in a data object write operation:
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Name

Name of the port.

Type

Data type of the port.

Precision

Maximum number of significant digits for numeric data types or maximum number of characters for 
string data types. For numeric data types, precision includes scale.

Scales

Maximum number of digits after the decimal point for numeric values.

Description

Description of the port.

Targets Properties

The target properties list the SAS data sets in the data object write operation.

Advanced Properties

The advanced properties allow you to specify the data object write operation properties to load data into SAS 
data sets.

You can configure the following advanced properties in the data object write operation:

Load Type

Configure the load type for the target.

Trace

Boolean property to implement the SAS trace option. Use the SAS trace option to toggle verbose logging.

Compress

Boolean property to implement the SAS compress option. When you enable the SAS compress option, 
target SAS data sets will be stored with compressed content.

PreSASCode and PostSASCode

Facilitates the invocation of a SAS Macro or a SAS %include statement to be executed just before or just 
after the loading of the SAS target object. The SPI Server must be configured to allow the execution of 
SAS exits. The SAS Macro to be invoked must be defined in the autoexec.sas file that is part of the SPI 
Server configuration.

Index Name (For Update Strategy)

Name of the index that defines the composite key to be used for the load type 'update-else-insert'. This 
option is used only in the case of a composite key.

Target Properties of the Data Object Write Operation
The target properties represent the data that is populated based on the SAS data sets that you added when 
you created the data object. The target properties of the data object write operation include general and 
column properties that apply to the SAS data sets.

You can view the target properties of the data object write operation from the General, Column, and 
Advanced tabs.
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General Properties

The general properties display the name and description of the SAS data set.

Column Properties

The column properties display the data types, precision, and scale of the target property in the data object 
write operation.

You can view the following target column properties of the data object write operation:
Name

Name of the column property.

Type

Native data type of the column property.

Precision

Maximum number of significant digits for numeric data types or maximum number of characters for 
string data types. For numeric data types, precision includes scale.

Scales

Maximum number of digits after the decimal point for numeric values.

Description

Description of the column property.

Is Primary Key

Determines if the column property is a part of the primary key.

Advanced Properties

The advanced property displays the physical name of the SAS data set.

Creating a Data Object Write Operation
You can create the data object write operation for one or more SAS data objects. You can add a SAS data 
object write operation to a mapping as a target.

1. Select the data object in the Object Explorer view. 

2. Right-click and select New > Data Object Operation. 

The Data Object Operation dialog box appears.

3. Enter a name for the data object operation. 

4. Select SASDataWrite as the type of data object operation. 

5. Click Add. 

The Select Resources dialog box appears.

6. Select the SAS data set for which you want to create the data object write operation and click OK. 

You can select only one data object for a data object write operation.

7. Click Finish. 

The Developer tool creates the data object write operation for the selected data object.
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Configuring Load Types
Load Type is a SAS target property that specifies how the Data Integration Service writes data to the physical 
SAS data object.

You can configure the following load types:

• Full load

• Append load

• Update Else Insert load

You can specify the load type in the Advanced tab of the Input Properties of a data object write operation.

Full Load

By default, the Data Integration Service uses full load when writing to a SAS data set. When you use full load, 
a SAS data set is created from the output, overwriting any existing data set. All attributes defined for the 
target definition is applied to the SAS data set, including indexes and (in)formats.

Append Load

With an append load, the Data Integration Service appends the mapping output to an existing SAS data set. If 
the layout of the target definition and the existing SAS data set do not match, an error condition occurs in the 
SAS processing. This error appears in the log file.

Update Else Insert Load

To update row values by an identifying key, choose the Update Else Insert Load. A proper key must be defined 
for the existing SAS data set to which the output is to be applied.
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C h a p t e r  5

SAS Run-Time Processing
This chapter includes the following topics:

• SAS Run-Time Processing Overview, 30

• SAS Dynamic Mapping, 30

• Fixed Partitioning, 32

• Rules and Guidelines for SAS Mappings, 33

SAS Run-Time Processing Overview
When you create a SAS data object operation, you define properties that determine how the Data Integration 
Service reads or writes data from SAS.

SAS Dynamic Mapping
You can use SAS data objects as dynamic sources in a mapping.

Use a dynamic mapping to accommodate changes to the source at run time. You can use a dynamic mapping 
to manage frequent schema or metadata changes or to reuse the mapping logic for data sources with 
different schemas. Configure rules, parameters, and general transformation properties to create the dynamic 
mapping.

If the data for a source changes, you can configure a mapping to dynamically get metadata changes at 
runtime. If a source changes, you can configure the read operation to accommodate changes.

In the Data Object tab of the data object read operation, select the At runtime, get data object columns from 
data source option when you create a mapping and then run the mapping. The source schemas are refreshed 
at runtime.

You do not need to manually synchronize the data object and update each transformation before you run the 
mapping again. The Data Integration Service dynamically determines transformation ports, transformation 
logic in the ports, and the port links within the mapping.

For information about dynamic mappings, see the Informatica Developer Mapping Guide.
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Developing and Running Dynamic Mappings
Perform the following tasks to develop and run a dynamic mapping to read from SAS.

The tasks and the order in which you perform the tasks depend on the mapping scenario and the 
transformations that you plan to use in the mapping.

1. Create a SAS mapping and add the SAS objects.

2. Configure a SAS dynamic source for the read operation to get metadata changes from the SAS source at 
run time.

3. To dynamically get columns from the data source file at run time, select At run time, get data object 
columns from the data source.

4. Configure a write operation to write to a SAS target.

5. Create and configure a run-time link to determine which ports to link at run time.

6. Validate the mapping.

7. Compile and run the dynamic mapping.

SAS Dynamic Mapping Example
Your organization receives customer data from different departments frequently. The departments might 
periodically change the source schema to include additional columns for departmental analysis. Your 
organization needs to incorporate all the updated data in a short span of time.

To refresh the source schema dynamically and fetch the changes from the data source, you create a dynamic 
mapping. Add all the dynamic ports to the target to override the metadata of the existing ports.

1. Import the SAS read and write data objects. 

2. Select a project or folder in the Object Explorer view. 

3. Click File > New > Mapping. 

The Mapping dialog box appears.

4. Enter the name of the mapping in the Name field. 

5. Click Finish. 

6. Drag the data object into a mapping. 

The SAS Data Object Access dialog box appears.

7. Select the Read option and click OK. 

8. In the Data Object tab, select the At runtime, get data object columns from the data source check box. 

9. Drag the data object into a mapping. 

The SAS Data Object Access dialog box appears.

10. Select the Write option and click OK. 

11. Select all the source incoming ports and add the ports to the target. 

12. Save and run the mapping. 
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Fixed Partitioning
You can configure fixed partitioning for a SAS data object operation in the native environment.

To configure fixed partitioning, you must first set the parallelism for the Data Integration Service depending 
on the number of partitions you want to configure, Then, specify the number of partitions that the Data 
Integration Service must create at runtime in the SAS data object operation properties.

Define the Maximum Parallelism for a SAS Mapping
You must set the maximum parallelism based on the number of partitions that you want to add. You can set 
the parallelism either in the Data Integration Service Properties or in the SAS mapping properties.

1. To set the maximum parallelism in the Data Integration Service properties, perform the following tasks: 

a. Navigate to the Execution Options section in the Administrator tool. 

b. Set the maximum parallelism based on the number of partitions that you want to configure. 

The following image shows the maximum parallelism set for the Data Integration Service based on 
the number of partitions:

c. Restart the Data Integration Service. 

2. To set the maximum parallelism in the SAS mapping, perform the following tasks: 

a. In the SAS mapping properties, click the Run-time tab. 

b. In the Execution Environment section on the right-hand side, enter the required maximum 
parallelism value for the native environment. 

The following image shows the maximum parallelism set in the mapping properties:

Configure Fixed Partitioning
After you set the maximum parallelism, configure fixed partitioning for the read or write operation.

1. Open the SAS data object read or write operation for which you want to configure fixed partitioning. 

2. On the Run-time tab in the Data Object Operation Details section, select Fixed as the Partition Type. 
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3. Specify the number of partitions that the Data Integration Service must create at runtime. 

The following image shows an example configuration of a fixed partitioning:

If the mapping includes writing data from a SAS object to any other target such as a flat file, use the 
Merge option to merge the results from multiple files created from the partitioning, and then run the 
mapping.

Rules and Guidelines for SAS Mappings
Use the following rules and guidelines when you configure SAS mappings:

• You cannot configure the Update Strategy transformation in a PowerExchange for SAS mapping. 
Alternatively, you can use the Load Type writer capability to model the update strategy.

• You cannot configure a Lookup transformation in a PowerExchange for SAS mapping.

• You can read data from compressed (COMPRESS=CHAR/YES or COMPRESS=Binary) and uncompressed 
SAS tables.

• You can read data from SAS tables with no limit to page size.

• You cannot directly read data from a SAS file that is created with data compression 
(COMPRESS=CHAR/YES or COMPRESS=Binary).

• When you directly read data from a SAS file, the page size of the file must not exceed 65536.
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A p p e n d i x  A

SAS Data Types Reference
This appendix includes the following topics:

• SAS Data Types and Formats, 34

• Character Data, 34

• Numeric Data, 34

• Date Time and Datetime Data, 35

SAS Data Types and Formats
SAS stores data that uses numeric and character data types. You can specify additional data type 
information by using SAS formats. SAS formats determine how the data is presented to the end user.

Character Data
The length attribute from SAS specifies the number of characters allowed in the column. The Developer tool 
uses this value as the scale attribute in the data object definition.

Numeric Data
For numeric data, the Developer tool uses the SAS format assigned to the column to determine the right 
precision and scale values.

For example, if the SAS format of a numeric column is 10.2, the column will be presented using 10 positions 
in total, including a decimal point and two digits after the decimal point. This is translated to a precision of 9 
and a scale of 2.

If no format is assigned to a numeric column, the Developer tool assigns a default precision of 8 and scale of 
0. This may not be adequate to hold the data. Adjust precision and scale manually to get a definition for the 
column that is adequate to hold the data you expect for the column.
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Date Time and Datetime Data
All Date, Time and Datetime columns are represented in SAS by numeric columns.

The format of the column usually indicates the intended use of the numeric column, but supported formats 
differ between SAS releases and localized versions. For this reason, when importing a SAS data object, the 
Developer tool does not attempt to determine whether a numeric column should be interpreted as a Date 
value, Time value, or Datetime value. These data types are available in a SAS data object definition, but you 
must manually assign them. The necessary conversion will then be done automatically.
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A p p e n d i x  B

SPI Server Configuration 
Parameters

This appendix includes the following topic:

• SPI Server Configuration Parameters, 36

SPI Server Configuration Parameters
The following table lists the SPI Server configuration parameters:

Section Parameter Description Example

ServerConfig Portnumber TCP/IP port number for the SPI 
Server listener process.

11080

ServerConfig SasAppPath Full path to the SAS executable. c:\progs\sas\V8\sas.exe

ServerConfig SasWorkingDir Directory path for the SAS working 
environment.

d:\spi\work

ServerConfig SasAutoExec Autoexec file that contains the library 
definitions.

autoexec.sas

ServerConfig LogFile Specifies the location of the server 
log file.

d:\spi\spiserver.log

ServerConfig SasLogMax Number of SAS log files stored by the 
server for reader sessions and writer 
sessions. Minimum is 12. Default is 
256.

256

ServerConfig SASPrePostCode Allow SAS exits (Yes/No). Yes

ServerConfig SpiTimeout Number of seconds that the SPI 
Server waits for SAS to start. 
Increase this value on very slow 
networks and when using a lengthy 
PreSAS command.

10
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Section Parameter Description Example

SpiUsers <username> Encrypted password. 89FD2A5347541028C9FA9A26A9057FF7

SpiAdmins <username> Encrypted password. 200CEB26807D6BF99FD6F4F0D1CA54D4
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A p p e n d i x  C

SAS Error Messages
This appendix includes the following topics:

• Client Messages, 38

• Data Integration Service Messages, 40

• Communication Component Messages, 45

Client Messages
Cannot connect to the SPI server, host = <host name>, port = <port number>, error = <error code>.

Explanation: The SPI Server TCP/IP port is not accessible.

User Response: Check the Communication component and network configuration. Verify that the SPI Server 
is running.

Cannot create field <field name>.

Explanation: The field cannot be defined in the repository.

User Response: Check for related messages.

Cannot initialize Windows Sockets.

Explanation: The Windows network environment is not properly configured.

User Response: Contact the Windows system administrator.

Failed to access config file data, wrong file format.

Explanation: The configuration file is accessible, but the content is invalid.

User Response: Check the configuration file.

Failed to add menu item <item name>.

Explanation: Internal error.

User Response: Contact Informatica Global Customer Support.

Failed to close the session.

Explanation: Internal error.
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User Response: Check the environment for a temporary network or operating system failure. Contact 
Informatica Global Customer Support.

Failed to load config file: <file name>, the file doesn't exist or it is not valid config file.

Explanation: The configuration file is not accessible.

User Response: Make sure the configuration file exists and is accessible.

Failed to open the help file: <file name>.

Explanation: The help file could not be found or could not be opened.

User Response: Check the client installation.

Failed to retrieve metadata, error code = <error code>.

Explanation: SAS does not start.

User Response: Check the SAS environment. Try to start SAS manually, and check the error messages from 
SAS.

Failed to retrieve SAS session log, error code = <error code>.

Explanation: The SAS log file could not be retrieved from the SAS machine.

User Response: Check the SPI Server log file for more information.

Failed to retrieve session ID.

Explanation: Internal error.

User Response: Contact Informatica Global Customer Support.

Failed to save config file: <file name>.

Explanation: The configuration file could not be saved.

User Response: Check the file system.

Library information is not available.

Explanation: The SAS session did not return the expected metadata.

User Response: Check the SAS log for error conditions.

No information available about table <table name>.

Explanation: The SAS session did not return the expected metadata.

User Response: Check the SAS log for error conditions.

No selection has been made.

Explanation: You tried to edit a field attribute before selecting an attribute.

User Response: Make a selection before attempting the edit.

Nothing has been selected for import.

Explanation: No items have been selected in the table tree.

User Response: Select an item.
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Received data has not valid format or the imported table/view has no columns.

Explanation: This should not occur in normal situations.

User Response: Check the SAS environment and the assigned library or table for abnormal conditions.

Session open request failed, host = <host name>, port = <port number>, error = <error code>.

Explanation: The SPI Server cannot initialize a session.

User Response: Check the SPI Server log for additional information.

SPI server login failed because of wrong user name or password.

Explanation: Authentication to the SPI Server failed.

User Response: Use the correct credentials to connect to the SPI Server.

The specified length of a numeric field is out of range (a valid value for SAS must be in the range from <value> 
to <value>). It will be set to the default value.

Explanation: The field length is invalid.

User Response: Enter a valid length or accept the default value.

Version mismatch is detected. The client version is not compatible with a server you are trying to connect to.

Explanation: The Client component of PowerExchange for SAS is not of the same version as the 
Communication component.

User Response: Make sure you install both components from the same version.

Data Integration Service Messages
10017 A version mismatch is detected. The client version is not compatible with a server you are 

trying to connect to.

Explanation: The Data Integration Service component of PowerExchange for SAS is not of the same 
version as the Communication component.

User Response: Make sure you install both components from the same version.

11010 Data field length exceeds the maximum value.

Explanation: The value for the length of the field is larger than that allowed by SAS.

User Response: Enter a valid length. Check SAS documentation for valid lengths.

10001 Cannot connect to the SPI server, host = <host name>, port = <port number>, error = <error 
code>.

Explanation: The SPI Server TCP/IP port is not accessible.

User Response: Check the Communication component and network configuration. Make sure the SPI Server 
is running.

40        Appendix C: SAS Error Messages



10002 Session open request failed, host = <host name>, port = <port number>, error = <error 
code>.

Explanation: The SPI Server cannot initialize a session.

User Response: Check the SPI Server log for additional information.

10003 Failed to retrieve a session ID.

Explanation: Internal error.

User Response: Contact Informatica Global Customer Support.

10004 Failed to close the session.

Explanation: Internal error.

User Response: Contact Informatica Global Customer Support.

10005 Requested not supported data type, field = <field name>, data type = <data type 
enumeration>.

Explanation: Internal error.

User Response: Contact Informatica Global Customer Support.

10006 Failed to retrieve SAS session log, error code = <error code>.

Explanation: The SPI Server cannot read or pass the SAS log file.

User Response: Check the existence and permissions of the SAS log file.

10007 Failed to retrieve connection attributes.

Explanation: Internal error. The SPI Server cannot read or pass the SAS log file.

User Response: Contact Informatica Global Customer Support.

10008 Failed to retrieve a host name.

Explanation: Internal error. Failed to retrieve the host name from the SAS database connection.

User Response: Contact Informatica Global Customer Support.

10009 Failed to retrieve a port number.

Explanation: Internal error. Failed to retrieve the port number from the SAS database connection.

User Response: Contact Informatica Global Customer Support.

10010 Failed to retrieve a library name from the extension field.

Explanation: Internal error. Failed to retrieve the value of the LibraryName metadata extension.

User Response: Contact Informatica Global Customer Support.

10011 SAS code generation failed, not supported data type: <data type enumeration>.

Explanation: Internal error.

User Response: Contact Informatica Global Customer Support.
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10012 Unexpected command received, command code = <command code>

Explanation: Internal error.

User Response: Contact Informatica Global Customer Support.

10013 The session has been aborted.

Explanation: The session has been aborted by the user.

User Response: Run the session again.

10015 SPI server login failed because of wrong user name or password.

Explanation: Authentication to the SPI Server failed.

User Response: Use the right credentials to connect to the SPI Server.

10016 Failed to retrieve 'trace' attribute from the extension field.

Explanation: Internal error. Failed to retrieve the value of the Trace session property.

User Response: Contact Informatica Global Customer Support.

10020 Failed to expand library name parameter.

Explanation: Internal error. Failed to expand the mapping parameter specified for the library name.

User Response: Contact Informatica Global Customer Support.

10021 Failed to expand table name parameter.

Explanation: Internal error. Failed to expand the mapping parameter specified for the table name.

User Response: Contact Informatica Global Customer Support.

10022 Failed to retrieve Pre SAS Code from the extension field.

Explanation: Internal error. Failed to retrieve the value of the PreSASCode metadata extension.

User Response: Contact Informatica Global Customer Support.

10023 Failed to retrieve Post SAS Code from the extension field.

Explanation: Internal error. Failed to retrieve the value of the PostSASCode metadata extension.

User Response: Contact Informatica Global Customer Support.

10028 Open SAS code not allowed.

Explanation: Specified SAS code is not allowed.

User Response: Enter allowed SAS code.

10031 Opening parenthesis not matched.

Explanation: Unmatched opening parenthesis found in the SAS code.

User Response: Correct the SAS code with proper closing parenthesis.

10032 Opening quote char not matched.

Explanation: Unmatched opening quote found in the SAS code.
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User Response: Correct the SAS code with proper closing quote.

10033 Invalid value for Pre/Post SAS Code.

Explanation: Specified SAS code is incorrect. See the log file for more information.

User Response: See the SAS documentation.

10035 The repository is not licensed for PowerExchange for SAS, or the license has expired.

Explanation: There is no valid license to use PowerExchange for SAS.

User Response: Install the proper license keys.

11004 Failed to retrieve the source table.

Explanation: Internal error. Cannot retrieve the table metadata for the SAS source object.

User Response: Contact Informatica Global Customer Support.

11006 Failed to retrieve data, error code = <error code>.

Explanation: SAS does not start.

User Response: Check the SAS environment. Try to start SAS manually and check the error messages from 
SAS.

11007 Failed to retrieve a where clause from the extension field.

Explanation: Internal error. Failed to retrieve the value of the WhereClause metadata extension.

User Response: Contact Informatica Global Customer Support.

11009 Failed to retrieve metadata extension attributes.

Explanation: Internal error. Cannot retrieve the mapping level SAS table object metadata from the 
mapping.

User Response: Contact Informatica Global Customer Support.

11010 Data field length exceeds maximum value.

Explanation: The value for the length of the field is larger than that allowed by SAS.

User Response: Specify a valid length. Check SAS documentation for valid lengths.

11012 Failed to expand where clause parameter.

Explanation: Internal error. Failed to expand the mapping parameter specified for the where clause.

User Response: Contact Informatica Global Customer Support.

11013 Failed to retrieve 'Join Type' from the extension field.

Explanation: Internal error. Failed to retrieve the join type from the mapping.

User Response: Contact Informatica Global Customer Support.

11014 Failed to retrieve 'Join Condition' from the extension field.

Explanation: Internal error. Failed to retrieve the join condition from the mapping.

User Response: Contact Informatica Global Customer Support.
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11018 For %s Only two sources per source qualifier are supported.

Explanation: More than two tables participate in the join and the join is not an inner join.

User Response: Limit the number of tables to two or specify an inner join.

11019 Failed to get the Primary key - Foreign key relation for creating the Join.

Explanation: Failed to retrieve the primary key and foreign key relations from the mapping where no join 
condition was specified.

User Response: Create primary key and foreign key relations in the data object, or specify a join condition.

15001 Failed to retrieve the target table.

Explanation: Internal error. Cannot retrieve the table metadata for the SAS target object.

User Response: Contact Informatica Global Customer Support.

15002 Failed to send data, error code = <error code>.

Explanation: SAS does not start.

User Response: Check the SAS environment. Try to start SAS manually and check the error messages from 
SAS.

15003 Failed to retrieve target instances.

Explanation: Internal error. Failed to retrieve the target instance from the session.

User Response: Contact Informatica Global Customer Support.

15006 Failed to retrieve indexes information from the extension field.

Explanation: Internal error. Failed to retrieve indexes from the metadata extension.

User Response: Contact Informatica Global Customer Support.

15007 Failed to load index information from the extension field.

Explanation: Internal error.

User Response: Contact Informatica Global Customer Support.

15008 Failed to retrieve key index information from the extension field.

Explanation: Internal error. Failed to retrieve the key index metadata extension.

User Response: Contact Informatica Global Customer Support.

15009 Failed to retrieve load type attribute from the extension field.

Explanation: Internal error. Failed to retrieve the value of the load type property.

User Response: Contact Informatica Global Customer Support.

15010 Failed to retrieve 'data compression' attribute from the extension field.

Explanation: Internal error. Failed to retrieve the value of the Compress session property.

User Response: Contact Informatica Global Customer Support.
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Communication Component Messages
A version mismatch is detected, the client connection has been rejected.

Explanation: The Data Integration Service or Client component of PowerExchange for SAS is not of the 
same version as the Communication component.

User Response: Make sure you install both components from the same version.

Failed to create SAS data code file <file name>.

Explanation: The indicated file could not be created in the working directory as specified in the 
Communication component configuration.

User Response: Check the configuration and the directory permissions.

Failed to generate SAS dummy log file.

Explanation: No empty SAS log file could be created.

User Response: Check the file and directory permissions, and the Communication component configuration.

Failed to open SAS log file <file name>.

Explanation: The SAS log file could not be opened.

User Response: Check the file and directory permissions, and the Communication component configuration.

Failed to receive data from SAS, errno = <error message>.

Explanation: SAS does not start.

User Response: Check the SAS environment. Try to start SAS manually, and check the error messages from 
SAS.

Failed to send data to SAS, errno = <error message>.

Explanation: SAS does not start.

User Response: Check the SAS environment. Try to start SAS manually, and check the error messages from 
SAS.

Failed to set SAS working directory <directory path>.

Explanation: Could not set the indicated path as the current working directory.

User Response: Check the existence of the directory and its permissions, and the Communication component 
configuration.

Failed to start SAS session, errno = <error message>.

Explanation: SAS does not start.

User Response: Check the SAS installation and the Communication component configuration.

Failed to stop SPI server, errno = <error message>.

Explanation: The SPI Server could not be stopped by using the spiserver command.

User Response: Make sure you specified the right host name and port number.
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Failed to write data to SAS data code file <file name>.

Explanation: Could not write the data to the indicated file.

User Response: Check the file permissions.

SAS session time out expired.

Explanation: The SAS process does not end.

User Response: Check the SAS log for possible problems.

SAS session wait failed.

Explanation: Internal error.

User Response: Contact Informatica Global Customer Support.

Unexpected command received, message ID = <message ID>.

Explanation: Internal error.

User Response: Contact Informatica Global Customer Support.

Unknown message received.

Explanation: Internal error.

User Response: Contact Informatica Global Customer Support.
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